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Purchase Requisitions

1 PURPOSE
The Requisition function of the Oracle Purchasing module will be used to generate and 
record all commitments within TFMS-M.  MTMC uses the term “commitment” 
interchangeably with “requisition”.  The requestor first creates a requisition, by entering 
an online requisition in TFMS-M.  Certain requisitions require the additional step of 
creating a document in the Form Flow system (Form Flow) and attaching it to the 
requisition.  The requisition must pass a funds checking step that checks and reserves 
amounts against the budget established at the beginning of the fiscal year.  The requestor 
then submits the requisition for approval.  Approvals are electronically routed using the 
workflow notification system based on the requestor position in the MTMC command.  
The approver reviews the requisition for completeness and accuracy and can reject, 
approve, or approve & forward the requisition for additional approvals.  Once the 
requisition has been approved the requisition will generate a Commitment entry in the 
General Ledger and automatically be made available for the Purchase Order process.  
MTMC uses the term “Obligation” interchangeably with “Purchase Order”.  The 
requestor is notified of the approval results.

The following Requisition Type table describes the MTMC types of requisitions:

Requisition 
Type

Description Form 
Flow #

INTERFUND INTERFUND
Local Travel Local Travel DD 1165
MIPR Military Inter Departmental Purchase Request DD 448
PCS Permanent Change of Station DD 1614
PCV Pre-Certified Voucher SF 1034
PR&C Purchase Request and Commitment DA 3953
Purchase Card International Merchants Purchase Authorization Card 

(IMPAC)
TDY Travel DD 1610
TRAINING Training DD 1556

2 ADDITIONAL REFERENCES

• TFMS-M Basic Navigation Manual

• TFMS-M Purchasing Manual (PO), Requisitioning
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3 OVERVIEW
The following diagram illustrates the steps the user will perform to create a requisition:

PO – Create Requisition 

3.1 (Step 1). Obtain Standard Document Number
The requestor is responsible for obtaining a standard document number (see section 7 
TWCF/APF Standard Document Number Formats) prior to the entry of the requisition.  
This number is a unique fourteen characters number that will generally become the 
Purchase Order number for the Obligation.  The standard document number is entered 
into the DFF (Data Flexible Field) on each of the lines of the requisition as well as the 
Form Flow document.  

3.2  (Step 2). Enter Requisition in TFMS-M 
Requestors enter requisitions by filling in the appropriate fields.

See section 4 Instructions – General. 

See section 6 Specific Requirements By Requisition Type. 
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3.3 (Step 3). Create Form Flow Document
For all requisitions that require a Form Flow document (see Requisition Type table in 
section 1 above) the user prepares the Form Flow document using information from the 
requisition. See section 6 Specific Requirements By Requisition Type for further details.

3.4 (Step 4). Attach Form Flow Document to Requisition
Once the Form Flow document is completed the document should be saved and attached 
to the requisition.  See section 4.5 Attachment, for detailed instructions on how to attach 
a Form Flow document to the TFMS-M requisition.

3.5 (Step 5). Submit for Approval
The requestor is always required to check the reserve funds field.  The system checks the 
availability of funds for the Project/Task, Expenditure, and organization and returns an 
immediate message to the requestor.  If the fund checking fails the requestor needs to first 
check the requisition information to confirm that the information was entered correctly.  
All funds inquiries can be routed to the Budget Department for help in determining 
proper classifications.  The requisition is automatically routed to the Approval Process 
upon successful completion of the funds checking process

3.6 (Step 6). Approval Process
The submitted requisition is automatically routed to an approver based on the requisition 
requestor and the MTMC command structure.  The approver is responsible for the 
following:

• Completeness and accuracy of the requisition.
• Required Form Flow documents and other required supporting documents 

attached.  
• Requisition agrees with attached documents.
• Electronic signature added to Form Flow documents where applicable.
• Funds Certification.  The proper Project, Task and Expenditure information has 

been entered.
• Authority for the purchase of goods or services.

If the requisition is rejected the approver routes the requisition back to the Preparer for 
the appropriate changes and the requisition is submitted for approval again.  Upon final 
approval of the requisition funds are committed.

Note:  An approver is held responsible as the “Authorized Certifying Officer”.  DFAS 
requires a signed DD577 form on record.  Please contact MTMC-Budget for additional 
information if you have any questions regarding the approver authority.  If a requisition is 
routed to an approver who does not have the “Authorized Certifying Officer” authority 
the approver needs to approve and forward to an approver with the required authority.

4 Instructions – General 
These following instructions apply to all requisitions entered into TFMS-M.  

Navigate to the Requisitions window from the menu, by selecting Requisitions, 
Requisitions from the Navigator window. 
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Double click to access the Requisition Header window.

4.1 Header 
When a user navigates to Requisitions from the Navigator menu, the following Enter 
Transaction Events window displays:
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Click on Transaction Event list of value icon.  The system defaults Transaction Event 
field to Requisitions and Transaction Code field to Commitments.  

Note: Do not enable the “Do not display this window again” checkbox.  If this is done it 
is necessary to close out of the Requisition form and navigate back to it.

Select OK button to proceed to the following Requisitions window:
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In the table below, required fields are displayed with a yellow background and display 
only fields are displayed with a grey background.

The following Requisitions – Header table outlines the requisition information:

Requisitions – Header Instructions Comments
Upper part 
Number System assigned when 

record is saved. 
Display Only.  Record this 
number in the FormFlow 
remarks sections.

Type “Purchase Requisition” Defaults
Preparer User who prepared 

requisition.
Display only. 

Description Enter a summary 
description for requisition.

This description is used to 
help locate requisitions.

Status Incomplete Defaults.
Total Displays currency format 

and sum of all requisition 
lines.

Display only.

Transaction Code Select “Commitments” 
from list of values.

Required. 

[ _ ] (Data Flex Field) Click on the field to select a 
Requisition Type.

See section 4.1.1 Header –
DFF Requisition Type 
section for further details.
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Requisitions – Header Instructions Comments
Requisition Lines (Tabs)
Items (Tab) Use the Items tabbed region 

in the Requisitions window 
to enter requisition line 
information

See section 4.2 Item (Tab) 
for further description.

Source Details (Tab) Not used at this time.
Details (Tab) Not used at this time.
Currency (Tab) Defaults to US Dollars 

currency. MTMC standard
Not used at this time.

Lower part Used to default to the line 
information.  May change 
for each line.

Destination Type “Expense” Required. Defaults. 
Requestor Same as Requestor. Required. Defaults to user 

preparing requisition.  See 
Perparer field above.  

Organization “MTMC GLOBAL” Required. Defaults.
Location Enter the requestor location. Required. Defaults from 

employee record
Subinventory Not used at this time.
Source “Supplier” Required. Defaults.
Supplier Enter the supplier. Optional.  Select supplier or 

employee for payment.  
Site Enter the site location if 

applicable.
Optional.  Select site.  Note:  
Employees have address 
and government charge card 
site. 

Contact Enter supplier contact or 
select from List of Values..  

Optional.

Phone Enter supplier phone or 
select from List of Values.

Optional.

Buttons
Catalog… (Button) Not used at this time.
Distributions…(Button) See section 4.3 

Distributions 
Approve (Button) See section 4.7 Submit for 

Approval

A window field prompt describes each field by telling you what kind of information 
appears in the field or what kind of information you should enter in the field.
Fields are color coded to indicate their type:

• White Fields - allow data entry
• White Fields with ‘’’ (three tick marks at the end of field) indicate a list of values 

for selection is present.
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• Yellow Fields - require data entry
• Gray Fields with Black Text - are display-only
• Gray Fields with Gray Text - are disabled
• Blue Fields - indicate fields to use in Query-Enter mode

Note: Yellow Fields (required) must be completed before the user can navigate to other 
fields.  All required fields must be completed before the requisition can be saved.

The user can select the save icon, at any time, to permanently save the requisition 
information.  Enter the system assigned requisition number in the accounting 
classification section of the Form Flow document. 

The following Requisition Status table lists the available requisition status options:

Requisition Status Description
Approved An approver with sufficient authority approved the requisition.  A 

buyer can now place the corresponding requisition lines onto 
purchase orders.

Cancelled A requisition preparer cancelled the requisition.
In Process The preparer completed the requisition and submitted to the 

approval process. No approvals have been made.
Incomplete The requisition is incomplete and the preparer has not yet 

submitted the requisition to an approver.
Pre-Approved At least one person with sufficient authority approved the 

requisition.  
Rejected The approver rejected the requisition.  Purchasing returns the 

entire requisition to the preparer.
Returned The buyer return the requisition.  Purchasing returns to the 

preparer all requisition lines within the same requisition that are 
not on a purchase order.

4.1.1 Header – DFF Requisition Type
When the requisition header data flex field (displayed as [  ]) is selected the following 
window appears:

Note:  Requisition Type TDY will have additional fields.  See section 4.1.2 Header –
DFF Requisition Type - TDY (Travel) for further details.
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Select the List of Value (LOV) icon to display the following list of MTMC requisition 
types. 

Select by highlighting (clicking) the desired requisition type.  Click OK to close the LOV 
and return to the DFF Requisition Header window to confirm the requisition type 
selected is displayed.

4.1.2 Header – DFF Requisition Type - TDY (Travel)
When the TDY requisition type is selected the following additional TDY fields are 
displayed.

The following Requisitions Headers - TDY table outlines the additional information to be 
entered.

Requisitions Headers –
TDY

Instructions Comments
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Requisition Type “TDY” Defaults from previous 
window selection.

Approx. No Days of TDY Enter number of days on 
travel.

Proceed Date Enter first date of travel. 
(Ex. 05-FEB-02)

Valid date entry examples:
05-FEB-02 or 05-FEB-2002 

ITINERARY FROM Enter the orgination point of 
the TDY travel

INITERARY TO Enter the destination(s) of 
the TDY travel

COMMERCIAL 
TRANSPORTATION

Enter any mode of 
commercial travel

Valid entries are: AIR, 
BUS, RAIL, SHIP or 
NONE

GOVERNMENT 
TRANSPORTATION

Enter any mode of 
Government provided 
transportation

Valid entries are: G-
VEHICLE, GOV-AIR, 
GOV-SHIP and NO GOV

LOCAL 
TRANSPORTATION

Enter any mode of local 
transportation

Valid entries are: CAR 
RENTAL, OTHER, TAXI 
and NO LOCAL

PER DIEM AUTHORIZED 
PER JTR

Enter “Yes” when using the 
JTR and “No” when other 
rate is authorized

OTHER PER DIEM RATE Enter the Authorized Per 
Diem rate

ADVANCE 
AUTHORIZED

Enter any authorized 
advance amount

Click on the OK button when complete to return to the requisition header.

4.2 Item (Tab)

Navigate to the Items tabbed region in the Requisitions window.  A blue icon to the left 
of the line number identifies the current line.  The following Requisition – Item Tab table 
outlines the information to be entered.

Note:  The Requisition Line information has a bottom scroll bar.  Scroll left or right to 
view the entire contents for the line.

Requisitions – Items Tab Instructions Comments

SCROLL LEFT

NUM Required. System assigns 
line numbers.

Type Required.  Defaults to 
Services.  Types - Goods, 
Services.
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Requisitions – Items Tab Instructions Comments
Item Optional. Not used at this 

time.
Rev Displays revision number. Display only.  
Category Select List of Value icon 

and select category and sub-
category.

Required. LOV 
instructions.

• Select 
Combinations 
button

• Enter Item=%, Sub-
Category=%.

• Select Category 
(Requisition Type) 
and Sub-Category = 
“Location”. 
(Example – MIPR, 
HQ MTMC – RM)

• Select OK button 
when complete.

Description Enter a description to 
explain the item in further 
detail.

Required.

Scroll Right
UOM (Unit of Measure) Required

Services = US Dollars
Goods =  Each, Hour, 
Measurement Ton, US 
Dollars.

Quantity Services – Enter travel or 
service amount.
Goods – Enter quantity.

Required.  Do not enter $ or 
“,”.  (Ex.  $5,700.25 = 
5700.25).

Price Enter goods unit price. Required
Services = Defaults “1”.
Goods = Unit Price.

Need-By Enter the date by which the 
item/travel is needed.

Optional. Format = 02-
FEB-02 or 02-FEB-2002.

Tax Code Display Only. Not used at 
this time.

Charge Account Displays account 
information for the line 
when distribution is 
completed.

Amount System computed. 
(Quantity * Price).

Required. Defaults.
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Requisitions – Items Tab Instructions Comments
Transaction Code “Commitments” Required. Defaults.
[ _ ] DFF Enter Standard Document 

Number 
Required.  See section 4.2.1 
Item – DFF Standard 
Document Number for 
further details.

4.2.1 Item – DFF Standard Document Number and Travel Cost Type
When the user tabs or clicks on the DFF field the following window appears:

The user enters the standard document number (SDN).  In most cases this 14 digit 
number will become the Purchase Order number.  See section 7 Standard Document 
Number Formats for a detail table that outlines the various formats.  

For TDY Requisitions the SDN will be populated by the system when the TDY line is 
saved.  However, to save the line an initial SDN must be entered.  Enter the traveler’s last 
name as a temporary place holder for the SDN. This temporary SDN will be overwritten 
by the system generated SDN when the line is saved. 

Note:  The standard document number contains the requisition number assigned by the 
system.  The Standard Document Number is a required field and must be entered before 
the requisition can be saved.  Therefore, the user enters the partial Standard Document 
Number (less the requisition number).  Select OK.  Select Save. Select the DFF field 
again and complete Standard Document Number by adding the requisition number.

The Travel Cost Type is used to detail cost by type on the TDY order.  The Travel Cost 
Type will default to “NO TRAVEL.”  For TDY requisitions, the Travel Cost Type must 
be changed to one of the following:  

Travel Cost Type Purpose
OTHER Any travel cost other than Per Diem or Transportation
PER DIEM Per diem cost
TRAVEL Transportation cost
NO TRAVEL For non-TDY requisitions
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4.3 Distribution (Button), Projects (Tab)
Select the distribution button, then project tab, for each line of the requisition to complete 
the accounting charge information.  The following windows displays the information to 
be entered.

Enter the project and task for the requisition

Next enter the Expenditure Type, Expenditure Organization and Expenditure date.  The 
following Requisitions – Distribution Button, Project Tab table outlines all the project 
fields:
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Requisitions –
Distribution Button, 
Projects Tab

Instructions Comments

Scroll Left
NUM Defaults Required. System assigned.
Project Enter or select Project. Required
Task Enter or select Task. Required
Contract Line Num Optional
Deliverable Num Optional
Award Skip Not used
Scroll Right
Expenditure Type Select EAC from list Required
Expenditure Org Select Organization Required
Expenditure Date Select or enter expenditure 

date
Required. 

Expenditure Quantity Defaults to balance of item 
amount.  Can be modified 
for multiple distribution 
lines.

Required. 

Account Description 
(Charge, Budget Accrual, 
Variance)

System displays the account 
descriptions based on the 
distribution line 
information.

Display Only.  See section 
4.3 Distribution (Button), 
Accounts (Tab) for 
additional information.

Note:  The system allows multiple distribution lines for a single requisition line.  If the 
sum of the distribution quantities, disagrees with the item line, the user cannot submit the 
requisition for approval.

The user can optionally select the Accounts tabbed region to view the charge account(s). 

Select Save.  Select close window to close the Distribution window are return to the 
Requisition window.

4.4 Distribution (Button), Accounts (Tab)
The following distribution window is displayed by the user selecting the Accounts tabbed 
region or selecting the Distribution button from the Requisition Header window.
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This window displays the system generated account information for the expenditures 
entered in the Projects tabbed region.

Optionally, select the Charge Account field, then select Edit Field (Pencil) on the tool bar 
to view the following Charge Account window:

Select OK to return to the Distribution window.

Close the window to return to the Requisition window.

4.5 Attachments  (Paperclip on Tool Bar)
Attachments will be used to link non-structured data such as text, Form Flow documents, 
images, word processing documents, spreadsheets and web pages.  Invoke the 
Attachment form window by pressing the Attachment (paperclip) in the tool bar as 
illustrated next. 
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Note:  The requisition must be saved before adding attachments.  The following message 
appears if the requisition has not been committed.

Select “Yes” to save the requisition and display the following Attachment window.

Enter a category.  The following table outlines the category selections:

Category Comments
Internal to Requisition Attachment only accessible from the requisition window.
Miscellaneous Viewed across all forms of the document.  Copies to the 

purchase order.  
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To Approver Only displayed to the requisition approvers.
To Buyer Only displayed from the purchase order.
To Receiver Only displayed when receipting the purchase order.  
To Supplier Specific attachments for the supplier.

Select “Miscellaneous” for all attachments unless the attachment is to be restricted.

Enter a description.  The description helps to identify the attachment. 

Enter a data type.

Data Type Comments
Document Reference Use document reference to point to documents 

maintained in a document management system.
File File documents are external files such as FormFlow 

documents, Microsoft Word files, Microsoft Excel files, 
image files such as .JPG files, or other types of files.  
When File type documents are attached, they are loaded 
into the database.  When a Files document is selected, the 
lower half of the Attachments window displays and 
“Open Document” button that invokes a web browser and 
passes the file to the browser.  The web browser handles 
displaying the file as appropriate based on its file name 
extension.

Long Text Enter text greater than 2000 characters.
Short Text Enter short text less than 2000 characters.
Web Page Web Page documents are attached as URLs in the format 

http://intranet.mtmc.army.mil.  When the user selects a 
Web Page Document to view, the lower half of the 
Attachments window displays an “Open Document” 
button that invokes a web browser and passes the URL to 
the browser. 

When Long Text or Short Text is selected the user can type or paste information into the 
lower section of the attachment.  Chose short text when generally the text entered is less 
than a page of text, otherwise long text is suggested.

When File is selected the user is prompted to upload the file by selecting the browse 
button and locating the file from the network or their PC.  The system displays a 
confirmation message “Has the file been uploaded successfully?” to confirm the file 
upload.  The Source Tab displays the reference to the file as “Internal”

When Web Page is selected the user is directed to the Source tab to enter the URL

If the attachment should not be modified, the user can uncheck the May Be Changed 
field.  The default is to allow modification.  



TFMS-M Standard Operating Procedures – Purchase Requisitions 

Version 1.1, January 7, 2003 21

The user selects Save from the Tool bar when the attachment is complete.  The system 
allows for unlimited number of attachments.  

The following message appears if the save was not performed.

Select Save. 

Select close window to return to the requisition.

4.5.1 Attachments for TDY Requistions
The requisition attachment is used to document any special requirements for the TDY 
order.  Data entered in the attachment will be printed in block 16 – Remarks of the 
DD1610.  The following are specific requirements for a TDY requisition:

Seq = 10
Category = Miscellaneous
Data Type = Long Text

4.6 Print Requisition (See 4.6.1 for TDY Requistions)
When the requisition is complete and ready to approve, the user needs to print a copy for 
their records.  Note the requisition number on the Requisition header screen.
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Select Requests from the View menu on the Toolbar or select Setup, Request from the 
Navigator window.  The following Find Request window displays:

Select Submit a New Request button.  The following ”Submit a New Request Message” 
is displayed.

Select OK to proceed to the Submit Request window.
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Select Printed Requisition Report

Enter requisition number in the From and To fields.  Modify any addition fields such as 
Print to and select Submit button to proceed to the Requests window.
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Select the Refresh Data button to monitor when the request Phase is Completed and the 
Status is Normal.  The report has now been sent to the printer specified.  

Select View Output button to view the requisition online.  Use the navigation buttons to 
navigate the report.  If additional printed copies are needed select Copy File from the 
Tools menu on the Toolbar.  Modify the font size or change the print preview options to 
landscape to compensate for paper size.  The system generates a temporary Netscape 
Web Page, as shown below: 
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Select File for Print options.  

Note:  Save a copy of report.  Select “Save As” from File Menu Option.  Select location 
for the file. Change the file name form FNDWRR.exe to (Requisition Number).doc.

When complete, close the Requests window and continue to approve the requisition.

4.6.1 Print TDY Requisitions 
When the TDY requisition is complete and ready to approve, the traveler will need a 
DD1610 for travel authorization purposes.  The DD1610 may be printed before and after 
approval.
 Note the requisition number on the Requisition header screen.
Select Requests from the View menu on the Toolbar or select Setup, Request from the 
Navigator window.  The following Find Request window displays:
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Select Submit a New Request button.  The following ”Submit a New Request Message” 
is displayed.

Select OK to proceed to the Submit Request window.
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Select MTMC DD1610 TDY FORM

Enter requisition number and click 
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Select the Refresh Data button to monitor when the request Phase is Completed and the 
Status is Normal.  

Select View Output button to view the DD1610 online.  The DD1610 will be presented 
on the screen as an Acrobat file.  By selecting the Print button on the menu bar, the 
DD1610 will be printed to your local printer.  You may save a copy of the print file by 
selecting the file button on the menu bar and chosing “Save a Copy….”

Note:  The DD1610 will not have the approvers name until the TDY requisition is 
approve.  See the next section for the approval process.

4.7 Submit for Approval
Once the requisition is complete, select the Approve button from the Requisition header 
window to open the Approve Document window:



TFMS-M Standard Operating Procedures – Purchase Requisitions 

Version 1.1, January 7, 2003 29

See the Requisitions –Approve button table below for instructions: 

Requisitions – Approve 
button.

Instructions Comments

Reserve Always click on the check 
box to enable.

Required

UnReserve Skip Not used at this time.
UnReserve Date Skip Not used at this time.
Submit for Approval Defaults enabled.  
Forward From Optional
Approval Path Optional
Forward To Optional
Note Note to Approver
Print Skip

Select OK when complete to have the system perform the submission checks (See section 
4.7.1 Submission Check Rules) and funds checking (See section 4.7.2 Fund Checking) as 
described below.

4.7.1 Submission Check Rules
• Each document must have at least one requisition line.
• Each requisition must have at least one distribution.
• Requisition line quantity must equal the sum of its distribution quantities.
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The system returns an error message prompting the user to enter the required information 
before the system proceeds with the Funds Checking and sends the requisition for 
approval.

4.7.2 Funds Checking
When the requisition has been submitted for approval and the “Reserve” checkbox has 
been highlighted the system checks that the requisition does not exceed the available 
funds. 

Note:  The user can also check funds availability at any time by selecting Check Funds 
from the Tool bar.

The follow message appears when the requisition exceeds the available funds.

The user selects OK.  Below is a sample of the Approval Errors window that displays and 
explanation.

Select OK.  The user reviews the requisition and verifies that the project, task, 
expenditure type, organization is correct.  Contact the Budget department to resolve any 
problems or issues.
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Once all issues are resolved the following pass fund confirmation message displays:

Select OK to proceed.  The following confirmation appears to notify the user that the 
requisition has passed the submission checks.

Select OK to proceed.  The following confirmation appears to notify the user that the 
requisition is submitted for approval

Select OK to proceed. The document is submitted for approval.  The requisition will be 
automatically routed to the required approver.   Approver actions are described in section 
5 Requisition Approval Process of this document 

4.8 Approval Notification 
When the final approver approves the requisition the system generates a notification to 
the preparer.  Navigate to the Notifications Summary from the Navigator window.  The 
following Worklist window displays the notifications to the requestor.
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The user can view additional detail by clicking on the subject line.  The following is a 
sample of the detail available:

Select the Close button to return to the Worklist.

Close the Worklist browser to return to the navigator window.

4.9 Requisition Summary
Navigate to the Requisitions, Requisition Summary from the Navigator to view 
requisitions.  The following Find Requisitions window allows the user to select 
requisitions.
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Enter as many criteria as desired.  In addition to the fields displayed above select the tabs 
to view additional fields.  Select the Results group (Headers, Lines, or Distributions) to 
determine which summary window to open.  Depending on the search criteria you have 
specified, all summary windows may not be available.  For example, if you specify 
criteria in the Accounting region, only the Distributions summary window is available.

Popular suggestions:
• Requisition Number
• Category (Item tab area) Example – Training, HQ – MTMC HQ
• Requestor
• Preparer
• Purchase Order (Related Documents tab)

Select Find (B) button to display the Requisition Summary window with the requisition 
that meet the entered criteria.  The next window depends on the Results Group selected

The following is a sample of the Requisition Headers Summary window when Header is 
selected in the results area of the Find Requisition window:
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The following information is displayed: Requisition Number, Preparer, Status, 
Description, Total amount, Currency, Creation Date, Type, Cancelled status, Finally 
Closed status, and Reserved status.

• Select the Lines button to drill down to the Requisition Lines Summary folder 
window. You can also select View Lines on the Tools menu to open this window.

• Select the New button to open the Requisitions window.
• Select the Open button to open the Requisitions window and query the requisition 

on the current line. Your options in this window depend on the status of the 
requisition and your approval and security options. For example, if a requisition 
has a status of In Process, you cannot open it from this window.

• Select View Distributions on the Tools menu to open the Requisition 
Distributions Summary folder window.

• Select View Action History on the Tools menu to open the Action History 
window.  Note: Use this window to display the history of all actions including 
approval.  For example, this window will display the pending approver.

• Choose the Lines button to open the Requisition Lines Summary window. Then 
select View Purchase Orders on the Tools menu to open the purchase order.

• Select Control on the Tools menu to open the Control Document window for the 
document on the current line. 

The following is a sample of the Requisition Line Summary window when Lines is 
selected in the results area on the Find Requisition window:
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The following information is displayed: Requisition Number, Line, Item, item Revision, 
Category, item Description, quantity Ordered, quantity Delivered, Type, UOM,
Price, Need By date, Requestor, Total amount, Currency, Modified status, Currency 
Price, Supplier, supplier Site, Supplier Item number, Source Document Type,
PO Number, PO Line number, Reference Number, Source Type, Source Organization, 
Source Subinventory, Destination Type, Destination Organization, Deliver To,
Destination Subinventory, Finally Closed status, Cancelled status, and Reserved status.

• Select the Distributions button to drill down to the Requisition Distributions 
Summary folder window. You can also select View Distributions on the Tools 
menu to open this window.

• Select the New button to open the Requisitions window.
• Select the Open button to open the Requisitions window and query the requisition 

on the current line. Your options in this window depend on the status of the 
requisition and your approval and security options. For example, if a requisition 
has a status of In Process, you cannot open its line from this window.

• Select View Distributions on the Tools menu to open the Requisition 
Distributions Summary folder window.

• Select View Action History on the Tools menu to open the Action History 
window.  Note: Use this window to display the history of all actions including 
approval.  For example, this window will display the pending approver.

• Select View Purchase Orders on the Tools menu to open the purchase order.
• Select Control on the Tools menu to open the Control Document window for the 

document on the current line.

The following is a sample of the Requisition Distribution Summary window when 
Distributions is selected in the results are on the Find Requisition window:
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The following information is displayed: Requisition Number, Line number, Distribution 
number, Item, item Description, UOM, Price, Quantity, Amount, and Charge
Account.

• Select the New button to open the Requisitions window.
• Select the Open button to open the Requisitions window and query the requisition 

on the current line. Your options in this window depend on the status of the 
requisition and your approval and security options.

• Select View Action History on the Tools menu to open the Action History 
window.  Note: Use this window to display the history of all actions including 
approval.  For example, this window will display the pending approver.

• Select Control on the Tools menu to open the Control Document window for the 
document on the current line

4.10 Control Requisition (Cancel, Finally Close)
Navigate to the Control Document window by Selected Control from the Tools menu in 
the Requisition Headers Summary and Requisition Lines Summary windows. 
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Select the control Action.
• Select Cancel Requisition Line
• Select Cancel Requisition. 
• Select Finally Close

If you selected the Cancel action, you can update the Action Date.  Note: Make sure the 
action date you specify lies in an open period.

Optionally enter a Reason for the action.
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5 Requisition Approval Process
The approver is responsible for the following:

• Completeness and accuracy of the requisition.
• Funds Certification.  The proper Project, Task and Expenditure information has 

been entered.
• Authority for the purchase of goods or services
• Required Form Flow documents and other required supporting documents 

attached.
• Add electronic signature for DD1610 (TDY – Travel) Form Flow documents 

emailed to you for your approval.
• Approval signatures added to all other Form Flow documents where required.  
• If not the final approver, route the requisition in TFMS-M to the next approver.

Use the Worklist Web page, accessible through the Notifications Summary menu in 
Purchasing, to manage your pending approval queue and take approval actions.
The following Worklist window contains an approval notification:

Select the requisition for approval my clicking on the subject line.  The following 
Notification Details window displays summary information from the requisition:
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Use the Open Document icon to drill down to the details of the requisition.

Purchasing offers the following document approval actions in the notification:
• Approve – Select this action to approve the requisition.
• Approve and Forward – Select this action to approve the requisition but forward 

this to another user for their approval also.  Enter the person to Forward To in the 
field provided.

• Forward – Select this action to forward the requisition without your approval to 
another person.   Enter the person to Forward To in the field provided.

• Reject – Select this action to reject the requisition.  This creates a rejection 
notification back to the preparer to make any adjustment as noted in the notes 
section and resubmit or cancel the requisition.

You can also reassign a notification to somebody else by selecting the Reassign button.  
The lower section displays the following:

Enter the person to reassign to along with any comments. 

Note:  Reassign action is not recorded in the Action History window, but a Forward 
action is.  To reassign a notification but still record you as the approver, choose Reassign, 
and then choose Delegate.  To forward the notification so that the new approver is 
recorded in the action history instead of you, open the notification and select the Forward 
action.

Chose the Submit button to complete the approval process and return to the Worklist.  
Use the close window or select Return to Worklist link to return without entering any 
approval action.

The requisition will be routed to all required approvers.  Upon final approval of the 
requisition funds are committed and available for the Purchase Order process where the 
obligation is entered.

6 Specific requirements by Requisition Type

The following Requisition Type table lists the MTMC requisition types in TFMS-M:

Requisition 
Type

Description Form 
Flow #

INTERFUND INTERFUND
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Local Travel Local Travel DD 1165
MIPR Military Inter Departmental Purchase Request DD 448
PCS Permanent Change of Station DD 1614
PCV Pre-Certified Voucher SF 1034
PR&C Purchase Request and Commitment DA 3953
Purchase Card International Merchants Purchase Authorization Card 

(IMPAC)
TDY Travel DD 1610
TRAINING Training DD 1556

Each requestor or desigee is responsible for entering their requisition into TFMS-M.  The 
following sections outline the specific requirements by requisition type.

TFMS-M requisition process automatically performs funds checking and creates the 
required DFAS accounting classification information.  The TFMS-M requisition approver 
is certifying that the requisition is properly funded and all the information entered on the 
requisition is accurate.

Approvers are required to have signed and mailed form DD557 to MTMC-Budget.   
MTMC will forward this information to DFAS.  This form gives the approver the ability 
to sign as “Fiscal Officer” or “Authorized Certifying Official”.  If needed, contact 
MTMC-Budget for additional information.  

The following matrix outlines the purchasing requirements:
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MTMC Overview of Purchasing 
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IMPAC Requestor
    Prepare Requisition (Quarterly) X
    Review Statement (Monthly) X
Enter Requisition
    Requestor or Designate X X X X X X X X
    PBO X
Create & Attach Form Flow 
    Requestor or Designate X X X X X X
Requisition Approval
    Supervisor X X X X X X X X X X
         Approve & Forward To:
         PARC (No Support Agreement) X
Aquiline Requisition Process/SPS X
AutoCreate Purchase Order
    MTMC-RM X X X X X X X X X X
Enter Receipt
MTMC-RM

    When Purchase Order created X X X X X X X
Requestor

    When goods/services received X X X
Prepare Voucher (DD1351 or 
DD1351-2)
    Requestor X X X
Route Voucher to RMF 
(Alexandria & Ft. Eustis)
    Requestor X X X
Route Voucher to DFAS
    Requestor X X
    MTMC-HQ X X
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6.1 Requisition Type – Interfund
Overview:
Interfund transactions pertain to the purchase of supply items from the stock fund where 
both the buyer and seller are DoD agencies.  The term interfund is derived by the method 
of payment where both parties are governmental and payment is made from the 
applicable Treasury fund and actual money is not exchanged.  An entry to the Treasury 
fund is simply made on the books to reflect the transfer of money from one agency to the 
other.  The interfund process, centralized for the entire DoD, is sometimes referred to as 
the Military Standard Billing System (MILSBILLS).

MTMC transacts only buyer’s interfund, not seller’s interfund.  MTMC purchases items 
through the interfund process but does not provide goods to others.

Additional Instructions/Information:
• Standard Document Number for the requisition will be assigned by the by the 

Property Book Officer.  See section 7 TWCF/APF Standard Document 
Number Formats for additional format information.  

• Example of Interfund transaction:
o MTMC command will identify a supply item is needed and send an 

email to the Property Book Officer (PBO)
o PBO enters requisition into TFMS-M and submits for standard 

approval process.  Enter “INTERFUND” as the supplier.
o MTMC-RM department Autocreates purchase order (obligation) and 

immediately enters the receipt.     
o Remaining processing is handled by DFAS.
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6.2 Requisition Type – Local Travel (SF 1164) Claim for Reimbursement For 
Expenditures On Official Business

Overview
• Requestor: 

o Enters requisition into TFMS-M.  See section 7 TWCF/APF Standard 
Document Number Formats for additional standard document format 
information.

o Create Form Flow document. See SF1164 Local Travel table below 
for additional instructions.  See section 8 LOA Instructions for 
instructions how to complete the Accounting Classification section.

o Save the SF1164 as a Form Package by selecting the Package 
(Envelope) icon.  Select “All” in the Data Records section and save the 
file with the requisition number and .FPK extension.

o Attach the Form Flow document to the requisition. See SF1164 below 
for sample of form.

o Submit the requisition for approval.
o Print the TFMS-M Requisition and Form Flow document.
o Route the SF1164 for the approvers signature.

• Approver is notified of pending approval.
o Approver receives the SF1164 document for approval.  Approver 

reviews the SF1164 and logs into TFMS-M, Notifications Summary to 
access the on-line approval notification..

o Review requisition for completeness and accuracy.
o Verify that the SF1164 agrees with the TFMS- M on-line requisition.
o Determine approval.  If not approved enter a reason and route the 

requisition back to preparer.  If approved, then select approve in the 
approval notification. The approver can route the requisition to 
additional approvers by selecting approve and forward. 

o Sign Block 8-Approved by: on the SF1164 form.
• Requestor - Notification of Approval.  Print a final copy of the requisition.
• MTMC-RM will record the obligation and immediately enter the receipt when 

the requisition is final approved
• Requestor – Send SF1164 to MTMC-RMF
• MTMC-RMF will review, confirming that the declaration text is included, 

then forward to DFAS.



TFMS-M Standard Operating Procedures – Purchase Requisitions 

Version 1.1, January 7, 2003 44

The following SF1164 Local Travel table provides instructions for completing the Form 
Flow document and maps the requisition source information:

SF 1164 – Local 
Travel

Requisition 
Section

Field Comments

1.  Department Header Organization Enter
2.  Voucher Number Skip
3.  Schedule Number Skip
4.  Claimant Name Header Requestor Add: Social 

Security, Mailing 
Address, Office 
Phone.

5.  Paid By Skip
6.  Expenditures Line Description Enter a line for 

each type of 
expenditure.  Add a 
text Attachment for 
declarations or 
additional text.

7.  Amount Claimed Header Total Enter
8.  Approved by: Approver signature.
9.  Certified Approval DFAS signature
10. Claimant Signature Requestor 

signature.
11 Skip
12. Skip
Accounting 
Classification

See section 8 LOA 
Instructions

Complete the Form Flow information and attach the document to the Requisition.

Sample SF1164 Local Travel Form:
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6.3 Requisition Type – MIPR (DD 448) Military Interdepartmental Purchase Request 
(Issuing a direct cite and reimbursable)

Overview:
MIPRs are issued when a government agency requests a service to be provided from 
another government agency.  There are two types of MIPR – a direct cite and 
reimbursable.  Direct cite MIPRs are used when the agency providing the service cites 
another agency’s funds for payment.  A reimbursable MIPR is used when the agency 
providing the service uses its funds, collects associated costs and is reimbursed for the 
services/costs provided. 

Additional Reference:
Standard Operating Procedure – Interagency and Intra-Agency Acquisitions

Issuing a MIPR:
• Requestor:

o Enters requisition into TFMS-M.  See section 7 TWCF/APF Standard 
Document Number Formats for additional standard document format 
information.

o Creates Form Flow document. See DD448 Military Interdepartmental 
Purchase Request table below for additional instructions.  
Note: Block 8 will always be “MTMC Global” for all MIPR’S.  Block 
14, see 8 LOA Instructions for detailed instructions on how to 
complete the line of accounting.

o If there is NOT an Interservice support agreement in place attach 
applicable supporting documents to the Form Flow document.  Sample 
minimum documentation required:
� Determination and findings (D&F) in one of the three acceptable 

formats.
� Detailed performance work statement including all required 

deliverables.
� Documentation in support of any request for other than full and 

open competition (justification and approval).
� Basis of acceptance of the services/supplies.
� Information Capability Request form.
� Fund cite and the basis for payment (reimbursable order, direct 

cite).
o Save the DD448 as a Form Package by selecting the Package 

(Envelope) icon.  Select “All” in the Data Records section and save the 
file with the requisition number and .FPK extension.

o Attach the Form Flow DD448 document to the requisition. See DD448 
below for sample of form.  

o Submit the requisition for approval.
o Print a temporary copy of the Requisition and Form Flow document.
o Route the DD448 for the approver’s signature.

• Approver is notified of pending approval.
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o Approver receives the DD448 with attachments for approval.  
Approver reviews the DD448 and logs into TFMS-M, Notification 
Summary to access the on-line approval notification.

o Review requisition for completeness and accuracy.  
o Verify that the DD448 form agrees with the on-line requisition 

information.
o Determine approval.  If not approved enter a reason and route the 

requisition back to preparer.  If approved, select approve or approve 
and forward in the notification. Sign DD448 block 15-Authorizing 
Official.

o All acquisition MIPR’s that do not have a Interservice support 
agreement must be approved and forwarded to Rosemary Kemp in 
PARC (Principal Assistant Responsible for Contracting) for additional 
review and approval.  Refer to PARC INTERAGENCY AND INTRA-
AGENCY ACQUISITIONS Standing Operating Procedure.  Sample 
minimum documentation required:
� Copy of the DD448 with signatures.  
� Determination and findings (D&F) in one of the three acceptable 

formats.  Include approver signature on D&F form.
� Detailed performance work statement including all required 

deliverables.
� Documentation in support of any request for other than full and 

open competition (justification and approval).
� Basis of acceptance of the services/supplies.
� Information Capability Request form.
� Fund cite and the basis for payment (reimbursable order, direct 

cite).
• Once approved, the DD448 package is sent to the requestor to be forwarded to 

the provider.
• Requestor – TFMS-M Notification of Approval.  Print a final copy of the 

requisition.  
• MTMC-RM will record the obligation when the Form Flow 448-2 is received 

from the supplier.
• The requestor records the Receipt when services are complete and the 

obligation can be paid. 
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The following DD448 MIPR table provides instructions for completing the Form Flow 
document and maps the requisition source information:

DD 448 MIPR Requisition 
Section

Field Comments

1.  Page Enter.
2.  FSC Skip
3.  Control Symbol Skip
4.  Date Prepared Date Prepared
5.  MIPR Number Header –DDF Standard Document See section 7 

Standard Document 
Formats

6.  Amend No. Header Requisition –
Revision

Enter

7.  To: Header Supplier/Site Enter
8.  From: Header Organization Always “MTMC 

Global”
9.  Items/Screening
Item Information and 
Description

Header Line Description View Requisition 
Attachments

10.  Attachment 
Notice
11. Grand Total Header Total Must agree with 

requisition.
12.  Transportation 
Allotment
13. Mail Invoices to:
14. Funds See section 8 LOA 

instructions
15. Authorizing 
Officer

Approver signature

16. Signature Requestor signature
17. Date Date Completed

Complete the Form Flow information and attach the document to the Requisition.

MIPR DD448 form:
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6.4 Requisition Type – PCS (DD 1614) Permanent Change of Station
Overview

• Requestor:
o Enters requisition into TFMS-M.  See section 7 TWCF/APF Standard 

Document Number Formats for additional standard document format 
information. 

o Prepare PCS worksheets.
o Create Form Flow document. See DD1614 Permanent Change of 

Station table below for additional instructions. 
Note: Accounting Classification (See section 8 LOA Instructions)

o Include a line for each expenditure type.  Include the Account 
Code and Amount.

o Save the DD1614 as a Form Package by selecting the Package 
(Envelope) icon.  Select “All” in the Data Records section and save the 
file with the requisition number and .FPK extension.

o Attach the Form Flow document to the TFMS-M requisition. 
o Print the DD1614 and PCS Worksheets and fax/mail the package to 

Betty Jackson at MTMC-PAL.  PAL department determines final 
entitlement. .

o Submit the requisition for approval and forward to Betty Jackson.
o Print a temporary copy of the Requisition.

• Approver is notified of pending approval.
o Approver receives DD1614 and PCS worksheets.
o Review requisition for completeness and accuracy.
o Verify that the DD1614 agrees with the TFMS-M on-line requisition.
o Determine approval.  If not approved enter a reason and route the 

requisition back to preparer.  If approved, select approve in the 
notification window.  

o Sign DD1614 block 23-Approving Official and Block 24-Order-
Issuing/Authenticating Office and return the package to the requestor.

• Requestor - Notification of Approval.  Print a final copy of the requisition. 
• MTMC-RM will record the obligation and immediately enter the receipt when 

the requisition is final approved.
• Requestor - When the travel is complete the requestor prepares DD1351. 

Travel Voucher attaching a copy of the approved DD1614.  Route for 
payment to:

o DFAS-IN (Indianapolis)
o MTMC-RMF – (Alexandria & Ft. Eustis travel vouchers)
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The following DD1614 PCS table provides instructions for completing the Form Flow 
document and maps the requisition source information:

DD 1614 – PCS Requisition 
Section

Field Comments

1.  Date Date Created
2.  Name Header Supplier Employee
3.  Social Security 
Number

Enter

4.  New Position Title Enter
5.  Grade or Rating Enter
6.  Retirement Code Enter
7.  Release Location Enter
8.  New Location Enter
9.  Reporting Date Enter
10.  Travel Purpose Enter
11. Travel Mode Enter
12.  Per Diem (For 
Employee, For 
Dependents)

Enter

13. Route Trip Travel Enter
14. Temporary 
Quarters

Enter

15. Household Goods Enter
16. Other Enter
17. Dependent 
Overseas Travel

Enter

18. Dependent Travel 
From (a), To (b)

Enter

19. Dependents Enter
20. Estimated Costs Enter
21 Trans Agreement
signed & date

Enter

22. Accounting Line Account Charge See section 8 LOA 
instructions

23 Approver Approver Signature
24 Order Issuing Approver Signature
25 Travel Order 
Number

Header DFF- Standard Doc 
Number

26 Date Signed Date Completed
27 Claimant
28 Remarks

Complete the Form Flow information and attach the document to the Requisition.
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Sample DD1614 PCS form:
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6.5 Requisition Type – PCV (SF 1034) Pre-Certified Voucher, (Public Voucher for 
Purchases and Services Other Than Personal)

Overview:
• MTMC-RM will create the TFMS-M requisition and attach the SF1034 Form Flow 

document to the requisition. Standard Document Number = Miscellaneous Obligation 
Number, See section 7 TWCF/APF Standard Document Number Formats for 
additional standard document format information.

o Save the SF1034 as a Form Package by selecting the Package (Envelope) 
icon.  Select “All” in the Data Records section and save the file with the 
requisition number and .FPK extension.

• Approver is notified of pending approval.
o Review requisition for completeness and accuracy.  Determine approval.  If 

not approved enter a reason and route the requisition back to preparer.  If 
approved.  

• MTMC-RM will auto create the purchase order and immediately enter Receipt.
• MTMC-RM will send SF1034 to DFAS.

The following SF1034 PCV table provides instructions for completing the Form Flow 
document and maps the requisition source information:

SF 1034 – PCV Requisition Section Field Comments
Voucher No
Department
Date Voucher 
Prepared
Contract Number & 
Date

Item Detail

Requisition Number 
and Date
Schedule No.
Payee’s Name Header Supplier
Explanation (Number 
and Date of Order, 
Date of Delivery, 
Articles or Services, 
Quantity, Unit Price, 
Amount

Item

Approver
Accounting 
Classification

Line Accounting Charge See section 8 LOA 
instructions 

Complete the Form Flow information and attach the document to the Requisition.

Sample SF1034 Pre-Certified Voucher form:
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6.6 Requisition Type – PR&C (Purchase Request & Commitment) 
Overview:

• Requestor:
o Enter requisition into TFMS-M.  TFMS-M standard document number 

= “TBR”. 
o Print a temporary copy of the Requisitions for requestor’s records.
o Submit the requisition for Approval and Forward to PAL for review 

and the addition of the PAL standard document number (e.g., 
W81GYE13549003).  

• Approver is notified of pending approval TFMS-M.
o Review requisition for completeness and accuracy.
o PAL will review the requisition and enter the PAL standard document 

number on the line DFF Standard Document Number field (replace 
“TBR”) and in the Approver Note field.

o Determine approval.  If not approved enter a reason and route the 
requisition back to preparer.  

• Requestor - Notification of Approval.  Print a final copy of the requisitions. 
Save an electronic copy of report.  See section 4.6 Print Requisition for 
detailed instructions. 

• Requestor enters requisition information into Aquiline system.  
o TFMS-M and Aquiline must agree in content and amount.
o To complete the Contract Level Funding section see section 8 LOA 

Instructions. 
o Attach the saved TFMS-M requisition report to the Aquiline 

requisition. 
o Submit the Aquiline requisition for approval. 

• Aquiline Approval
o The aquiline requisition is routed for approval.  Note: MTMC is 

currently working on an enhancement to interface requisitions from 
TFMS-M to the SPS system, eliminating the aquiline requisition.

o Verify that the TFMS-M requisition and Aquiline requisition agrees.
• Aquiline routes the approved Aquiline requisition to the SPS system.
• When a contract award is made MTMC-RM autocreates the purchase order in 

TFMS-M.  The purchase order number is the contract number and delivery 
number (ex. 2134-0001). 

• Requestor enters receipts when goods or services are received. 
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6.7 Requisition Type – Purchase Card (IMPAC)
Additional Reference:

Standard Operating Procedures – Credit Cards (MTMC Web Page)

MTMC SOP FOR GOVERNMENT-WIDE COMMERCIAL PURCHASE CARD 
(MTMC Web Page)

Overview:
• Each purchase cardholder receives an annual budget for the new fiscal year.
• The purchase cardholder enters a requisition for the quarterly budget amount into 

TFMS-M.  See section 7 TWCF/APF Standard Document Number Formats for 
additional standard document format information.

• Approver is notified of pending approval.
o Review requisition for completeness and accuracy.  Determine approval.  If 

not approved enter a reason and route the requisition back to preparer.  If 
approved., then select approve or approve and forward in the notification.

o The purchase cardholder receives a monthly statement from US Bank.  The 
cardholder reviews the statement and prepares the summary charge 
distribution.  Copies are sent to DFAS and MTMC-RM.

• MTMC-RM will autocreate a monthly purchase order (obligation) from the 
cardholders approved requisition.  The purchase order line distribution is 
modified to reflect the summary charge distribution.  The purchase order number 
will be assigned using the following 14 digit format:

Position Description
1-5   Constant “IMPAC”
6-9   Julian Date of Statement (Year, Day of Year)
10-14 First 5 Letters of cardholder name

• MTMC-RM will immediately receipt the purchase order.  
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6.8 Requisition Type – TDY (DD 1610)
Overview:
All travel orders (CONUS, OCONUS, and OCONUS direct hires) will be entered into 
TFMS-M as a requisition.  Once the commitment has been approved, MTMC-RM will 
autogenerate the purchase order.  After returning the traveler submits a travel voucher to 
DFAS-Indianapolis for rate calculation and payment.  If over the original amount the 
requestor will be notified to prepare a requisition for the difference referencing the 
original standard document number and submit for approval.  MTMC-RM will add the 
additional amount to the purchase order.

• Requestor: 
o Enters requisition into TFMS-M.  Create a line for each type of travel 

cost; Per Diem, Transportation and Other.  One requisition line must 
be created for each distribution line and expenditure type.  Do not 
create multiple distribution lines for a single requisition line.Save the 
requisiton after completing each requisition line and distribution line.

o
o .
o
o Submit the TFMS-M completed requisition for approval.
o Print a copy of the Requisition.  

• Approver is notified of pending approval.
o Review requisition for completeness and accuracy.
o Determine approval.  If not approved enter a reason and route the 

requisition back to preparer.  If approved, approve the approval 
notification. The approver can route the requisition to additional 
approvers by selecting approve and forward.

• Requestor - Notification of Approval.  Print a final copy of the requisition and 
Form Flow documents.  

• MTMC-RM will record the obligation when the requisition is final approved.  
MTMC-RM autocreates a purchase order for line one of the requisition.  Lines 
for Airfarewill be added to an existing airfare (Bank of America) purchase 
order for the current month. 

• MTMC-RM will record receipts when the purchase order is autocreated.  
• Requestor - When the travel is complete the requestor prepares DD1351-2 

Travel Voucher attaching a copy of the approved DD1610 and receipts.  
Route for payment to:

o DFAS-IN (Indianapolis)
o MTMC-RMF – (Alexandria & Ft. Eustis travel vouchers)

Sample DD1610 TDY form:
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6.9 Requisition Type – Training (DD 1556)
For non-government training less than $25,000 see Government-Wide Purchase Card for 
Training Operating Procedure on the MTMC website for instructions.  

All other training requires entering a TFMS-M requisition as outlined below:
Requestor: 

• Enter requisition into TFMS-M.    See section 7 TWCF/APF Standard 
Document Number Formats for additional format information.

• Create Form Flow document. See DD1556 TDY table below for additional 
instructions.  See DD1556 below for sample of form. See section 8 LOA 
Instructions for instructions to add block 27 Accounting Classification.

• Save the DD1556 as a Form Package by selecting the Package (Envelope) 
icon.  Select “All” in the Data Records section and save the file with the 
requisition number and .FPK extension.

• Attach the Form Flow DD1556 document to the TFMS-M requisition.  Submit 
the requisition for approval.

• Print a copy of the Requisition and Form Flow document. 
• Route the DD1556 to approver. 

Approver:
• Approver is notified pending approval.

o Approver receives DD1556 form for approval.
o Approver reviews the DD1556 and logs into TFMS-M, Notification 

Summary to access the TFMS-M on-line approval notification.
o Review requisition for completeness and accuracy.
o Determine approval.  If not approved enter a reason and route the 

requisition back to preparer.  If approved, select approve or approve 
and forward in the approval notification window. The approver can 
route the requisition to additional approvers by selecting approve and 
forward.

o Requestor’s supervisor signs DD1556 block 29-Signature of Fiscal 
Officer and block 32-Supervisor.   The requestor then routes the 
DD1556 form for block 33-Training Officer and block 34-Authorizing 
Official signatures not signed by the supervisor.  

Requestor:
• Notification of Approval and receipt of the DD1556 document. Print a final 

copy of the requisition.  
MTMC-RM:

• Records the obligation when the requisition is final approved.  MTMC-RM 
autocreates a purchase order for line one of the requisition.  Line two (Airfare) 
is added to an existing airfare (Bank of America) purchase order for the 
current month. 

• Record receipts when the purchase order is autocreated.  
Training Official: (When training is completed)

• DD1556 block 35 & 36 completed by the training official.
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• Add additional training information to DD1556 when training is complete and 
send to DFAS-Indianapolis with attached receipts.

• Enter TMFM-M Receipt.

The following DD1556 Training table provides instructions for completing the Form 
Flow document and maps the requisition source information:

DD 1556 – Training Requisition 
Section

Field Comments

A. Agency Enter
B. Standard Document 
Number

Enter See section 7 
Standard Document 
No.

C. Process Code
D. Amendment No.
1.  Name Header Requestor Enter
2.  Last Name Header Requestor Enter
3.  Social Security 
Number

Enter

4.  Ed Level Enter
5.  Continuous Fed Sv Enter
6.  Home Address Enter
7.  Phone Numbers Enter
8.  Position Title Enter
9.  Position Level Enter
10.  Pay Plan/Grade Enter
11. Organization Header Organization Enter
12. Org. Mailing Enter
13. Org. UIC Enter
14. Type of 
Appointment

Enter

15. No. Prior Non-
govern training days

Enter

16. Handicapped Y/N Enter
17. Title Enter
18. Objective Enter
19. Training Source Enter
20. Course Code Enter
21. Course Hours Enter
22. Course Identifiers Enter
23. Training Period Enter
24. No expenditure Enter
25. Direct Costs Enter
26. Indirect Costs Enter
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27. Accounting 
Classification

See section 8 LOA 
instructions

28. Labor Costs Enter
29. Fiscal Officer Approver Signature
30. Total Costs Header Total Amount Enter
31. Job Order No.
32. Supervisor Approver Signature
33. Training Officer
34. Authorizing 
Official

Approver Signature

35. Course Acceptance
36. Course 
Completion
37. Billing Instruction
38. Certifying Govn 
Official

Complete the Form Flow information and attach the document to the Requisition.

Sample DD1556 Training form:
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6.10 Requisition Type – Miscellaneous Obligation Document (DA 3717)
Additional Instructions/Information:
MTMC-RM:

• Prepares DA3717 document.
• Prepares requisition in TFMS-M.  Standard Document Number = Miscellaneous 

Obligation Number.  See section 7 TWCF/APF Standard Document Number 
Formats for additional format information  

• Attach a copy of the DA3717 document to the requisition and submit the 
requisition for approval.

• Approver is notified of pending approval.  Review requisition for completeness 
and accuracy.  Determine approval.  If not approved enter a reason and route the 
requisition back to preparer.  If approved, the approver can route the requisition to 
additional approvers by selecting approve and forward.

• When requisition is approved prepare Purchase Order and immediately enter a 
receipt.
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7 TWCF/APF  Standard Document Number Formats
The following  Types table outlines the requisition types and their related standard 
document  14 digit structure:

TY = Type

FY = Fiscal Year
FAC = Facility
JD = Julian Date  (Year, Day of Year)
LN = First digits of Last Name
LSS = Last 4 digits Social Security Number
##### Requisition Number (Last Digits)
P Pal Number
DoDACC DoD Agency Code

CAL= Calendar Month Alpha Conversion Chart

Types 1 2 3 4 5 6 7 8 9 10 11 12 13 14

MIPR M I P R FY CAL
FAC
ASN

FAC
ASN

FAC
#

FAC
#

# # # #

Training –
Individual T N G LN LN LN LSS LSS LSS LSS FY # # #

Training –
Group T N G G R P JD JD JD JD FY # # #

Travel –
Individual LN LN LN LSS LSS LSS LSS TY CAL # # # # #

Travel – Group G R P JD JD JD JD TY CAL # # # # #

Charge Card I M P A C JD JD JD JD LN LN LN LN LN

Interfund D o D A C C JD JD JD JD P P P P

Misc OBL –
MOD M O D FY FY CAL

FAC
ASN

FAC 
ASN

FAC
#

FAC
#

# # # #

Reimbursable 
RWA R W A M E P FY FY CAL # # # # #

Cost Transfer C O S T T R A N CAL FAC FAC # # #

Labor 
Adjustment L A B O R A D J CAL # # # # #

A Long Term TDY

B Blanket Order Travel

D Medical TDY

E Emergency Leave

L Local Travel

P Permanent Change of Station

T Temporary Duty

Jan Feb Mar Apr May Jun July Aug Sept Oct Nov Dec
    D E F G H J K L M A B C
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8 LOA (Line of Accounting) Instructions
The requestor is responsible for preparing the Accounting Classification sections in all 
Form Flow documents.  The preparer of the requisition completes the 
project/task/expenditure type information for the requisition lines.  The system then 
assigns the TFMS-M line of accounting (LOA) based on the information entered.  
Initially the user will need to use a table to map the TFMS-M LOA to the DFAS LOA.  
An enhancement is currently being coded to provide the DFAS LOA on a custom 
requisition report available to the requestor.  

The following DFAS LOA Instruction table is used to map the TFMS-M accounting code 
to the DFAS LOA:

DFAS LOA Instruction TFMS-M Accounting Code Segment
1. Department Fund
2. Transfer Department Fund
3. Fiscal Year Fund
4. Basic Symbol Fund
5. Limitation Limit
6. Operating Agency “35”
7. Facility Code/ASN ASN/CMD Facility Code
8. Program Program/AMSCO
9. Cost Center Cost Center
10 Element of Resource Element of Resource
11 Standard Document Number Standard Document Number (14 Digit)
12.Fiscal Station Number TWCF = 389900, APPR = S28113

TFMS-M LOA:
Requisition Line Item, DFF Standard Document Number field (Ex. IMPAC3001PRUNTY)
Requisition Line Item, Accounting Code field (Pencil on Tool Bar) 
Sample of TFMS-M Accounting Code screen with segments displayed:

Use the above DFAS LOA Instruction table to map the line with the following result:

9700XXXXXXXX4930.FD30.356466.TTTZ0000000.4100.252G.IMPAC3001PRUNT.389900


